Capitolo 2. Utilizzare questo documento e ottenere assistenza



Questo documento è consultabile in due modi:
	tramite le descrizioni dei componenti dell’interfaccia grafica (GUI) si accede alle spiegazioni delle opzioni disponibili e alle loro funzioni, con collegamenti alle descrizioni più approfondite e alle istruzioni di utilizzo; Capitolo 4, Panoramica delle finestre e delle opzioni del menu di GnuCash;

	classificando operazioni, compiti, o funzioni a seconda che si tratti di un conto, di una transazione, di un resoconto o altre operazioni particolari. Per esempio possono essere:
	Operazioni sui conti - Capitolo 5, Impostare, modificare e lavorare con i conti

	Operazioni con transazioni e registro - Capitolo 6, Operazioni comuni per le transazioni

	Strumenti e assistenti - Capitolo 7, Strumenti e assistenti

	Resoconti e grafici - Capitolo 8, Resoconti e diagrammi

	Personalizzazione - Capitolo 9, Personalizzare GnuCash






Accedere all’aiuto



Questa finestra viene visualizzata accedendo al menu Aiuto e scegliendo o Guida ai concetti e manuale oppure Sommario (F1). la sezione chiamata «Struttura dei conti - Menu Aiuto»
La finestra di aiuto ha una barra degli strumenti il cui significato è descritto nel seguito.
	Indietro mostra l’argomento visualizzato in precedenza.

	Avanti mostra l’argomento visualizzato in precedenza.

	Aiuto permette di accedere alle pagine di aiuto di GNOME.

	Cerca Inserire qui il termine da ricercare nell’Aiuto di GNOME. Non cerca nell’aiuto di GnuCash.



Il lato destro della finestra di aiuto mostra la pagina attualmente aperta. Il lato sinistro contiene invece la lista degli argomenti. Selezionando uno degli argomenti dell’aiuto, la corrispondente pagina verrà aperta nella finestra di destra.


Guida ai concetti e manuale di GnuCash



La guida è il complemento a questo aiuto; spiega infatti i concetti utilizzati in GnuCash e presenta un esempio che accompagna l’utente attraverso tutte le fasi dell’utilizzo di GnuCash per gestire i propri conti. La guida verrà aperta se si sceglie Aprire la guida per i nuovi utenti nella finestra di Benvenuto in GnuCash!.
Per aprire questa guida selezionare Aiuto → Guida ai concetti e manuale dal menu.
Si raccomanda di leggere questa guida se si sta utilizzando GnuCash per la prima volta o se non si ha familiarità con i concetti della contabilità.

Impostare una nuova struttura dei conti



Questa procedura assiste l’utente nella creazione di un gruppo di conti in GnuCash. Apparirà se verrà selezionato Crea nuova struttura conti nel menu di Benvenuto in GnuCash!.
Verrà così creato un nuovo file vuoto di GnuCash e avviato automaticamente l’assistente per l’Impostazione di una nuova struttura dei conti.
Suggerimento
Per avviare l’assistente manualmente, andare in File → Nuovo per creare un nuovo file. Per avviare l’assistente all’interno di un file aperto, andare in Operazioni → Nuova struttura conti... quando è visualizzata la scheda della struttura dei conti.

	L’assistente per l’Impostazione di una nuova struttura dei conti si apre con una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.
	Annulla — esce dall’assistente e annulla la creazione di una nuova struttura dei conti.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Avanti —  permette di avanzare nella procedura guidata.




	La schermata successiva permette la Scelta della valuta da utilizzare come predefnita per i conti.
	La lista a comparsa Valuta: è impostata al valore configurato nella scheda Conti delle Preferenze di GnuCash  (la sezione chiamata «Conti»). Per assegnare ai propri conti una valuta predefinita differente, basta selezionarla dalla lista.

	Il tasto Avanti è utilizzato per confermare la selezione e procedere alla schermata successiva.




	La schermata successiva riguarda la Scelta dei conti da creare.
Verrà visualizzata una schermata suddivisa in tre parti
	La parte in alto a sinistra presenta una lista di Categorie per le strutture di conti più comunemente utilizzate. Selezionare dalla lista quella che si desidera utilizzare. È possibile selezionare tutte le categorie che si desidera.

	La porzione in basso a sinistra presenta una Descrizione della categoria che mostra una descrizione dettagliata della categoria selezionata.

	La porzione di destra riporta la lista dei Conti che verranno creati dalla categoria selezionata.

	Il pulsante Seleziona tutto permette di includere tutte le categorie disponibili.

	Il pulsante Cancella tutto permette di deselezionare tutte le categorie selezionate.




	La schermata successiva riguarda l’Impostazione dei conti selezionati che prevede l’inserimento dei Bilanci di apertura e l’eventuale marcatura dei conti come Segnaposto.
Nota
I conti dei capitali non hanno un bilancio di apertura pertanto questo campo è bloccato e impostato a zero da GnuCash.

Nota
I conti segnaposto sono utili per creare una struttura dei conti e normalmente non hanno né transazioni né bilancio di apertura.

Seguire le istruzioni a video su come selezionare un conto e inserire il bilancio di apertura. Un singolo clic permette di selezionare un conto.
	Sul lato sinistro della schermata, c’è una lista dei Nomi dei conti. Selezionare un conto con un singolo sul clic sul suo nome: verrà così aperto il campo del nome per applicare dei cambiamenti.

	Il lato destro fornisce delle opzioni selezionabile attraverso le quali è possibile indicare se il conto è un Segnaposto e un campo per aggiungere il Bilancio d’apertura per il conto selezionato. Anche qui un singolo clic nella colonna del Bilancio d’apertura o nella colonna Segnaposto apre il relativo campo per effettuare dei cambiamenti.




	La schermata di Conclusione della configurazione dei conti è l’ultima e fornisce una descrizione delle tre scelte possibili per terminare l’assistente.
	Annulla — esce dall’assistente e annulla la creazione di una nuova struttura dei conti.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Applica — crea i conti che sono stati selezionati.






Si dovrebbe ora avere una struttura dei conti nella finestra principale di GnuCash.

Importare i file QIF



Questo assistente assiste nell’importazione di file Quiken (QIF). Verrà aperto se si seleziona Importare file QIF nella finestra di Benvenuto in GnuCash!.
Per avviare manualmente l’assistente, andare in File → Importa... → Importa QIF....
Nel seguito tutte le schermate che possono essere visualizzate in questo assistente sono descritte in ordine di apparizione.
	L’ assistente per l’Importazione dei file QIF si avvia presentando una finestra contenente una breve descrizione delle sue funzionalità. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.
	Annulla — esce dal processo e annulla l’importazione di file QIF.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Indietro — fa apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Avanti —  permette di avanzare nella procedura guidata.




	Nella schermata successiva verrà richiesto di Scegliere un file QIF da caricare. Il pulsante Seleziona... in questa finestra permette di accedere alla lista di file e cartelle aprendo il dialogo per Scegliere il file QIF.
Navigare fino alla posizione in cui sono stati salvati i propri file QIF; selezionare il primo fra quelli che si desidera importare e premere Importa. La schermata successiva visualizzerà il nome del file nella finestra per Scegliere il file QIF da importare..
Nota
Se il file che si sta caricando non possiede una data QIF verrà visualizzata la finestra per Impostare un formato di data per il file QIF. Selezionare quello appropriato dal menu a comparsa e continuare.

Nota
Se il file che si sta caricando non contiene un nome del conto verrà visualizzata la finestra per Impostare il nome predefinito del conto QIF. Diversamente verrà invece visualizzata la finestra descritta nella prossima sezione dove saranno visualizzati i file QIF caricati.
	Il campo del Nome del conto: permette di impostare un nome del conto per il file QIF.





	La pagina successiva visualizza i File QIF che sono stati caricati. È possibile tornare alla pagina precedente e selezionare altri file QIF. Qui è anche possibile eliminare qualsiasi file che sia stato caricato per errore.
	Il pannello superiore visualizza l’elenco dei file QIF che sono stati caricati.

	Il pulsante Carica un altro file riporta alla schermata precedente per aggiungere alla lista un ulteriore file QIF.

	Il pulsante Scarta il file selezionato permette, dopo aver selezionato un file nell’elenco presente nel riquadro superiore, di rimuoverlo dall’elenco.



Quando sono stati selezionati tutti i file QIF da importare, fare clic sul pulsanti Avanti.

	A seconda del tipo di dati contenuti nei file QIF da importare, verranno visualizzate una o più delle seguenti schermate:
	Conti e azioni
	Questa schermata fornisce una descrizione del processo di associazione di Conti e azioni che avverrà nella schermata successiva relativa all’Associazione dei conti QIF ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione dei conti QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi dei conti QIF a sinistra e, a destra, il Nome del conto GnuCashCreare una struttura dei contiCreare una struttura dei conti



La struttura dei conti è come una indice delle proprie finanze. Il miglior modo per concettualizzare una struttura dei conti è di pensarla come un albero. I rami principali rappresentano intere categorie o gruppi, mentre le foglie dell’albero rappresentano conti bancari o categorie di uscite. Quando viene richiesto un resoconto sommario, tipicamente solo i rami principali vengono riportati, invece che i conti individualmente. Per esempio, una struttura dei conti potrebbe assomigliare alla seguente:


300 Uscite | +--310 Bollette | | | +--311 Birra | | | +--312 Abbonamento TV | +--320 Uscite di lavoro | | | +--321 Dichetti | | | +--322 Dischi Blue Ray | | : :



Codici dei conti
I conti non hanno solo dei nomi; possono avere anche dei codici, per essere ordinati. Quando viene generato un resoconto, l’ordinamento è determinato dalla numerazione. È consuetudine che i numeri dei sottoconti non terminino con zero, mentre i conti padre abbiano numeri crescenti dallo zero.

Avvertimento
GnuCash non impedisce che vengano utilizzati dei numeri duplicati, comunque se ne scoraggia l’utilizzo. I codici dei conti sono trattati come numeri in base 36, quindi, se si terminano i numeri, è possibile utilizzare le lettere dalla a alla z.


Transazioni in valuta multiplaTransazioni in valuta multipla



Attualmente i trasferimenti fra conti aventi valuta diversa sono possibili solamente attraverso la finestra del trasferimento fondi descritta più sopra (la sezione chiamata «Finestra di trasferimento fondi»). Questa finestra è necessaria per inserire il tasso di cambio.
Per assegnare a un conto una valuta diversa, modificarne le proprietà cambiando il campo della Commodity nella valuta desiderata. Selezionando ora questo conto nella finestra del trasferimento fondi, verrà abilitata la sezione del trasferimento in valuta.

Pianificare le transazioniPianificare le transazioni



Le transazioni pianificate consentono di essere avvisati o di inserire automaticamente le transazioni in una data specificata. Questa proprietà combinata con l’assistente Dall’ultimo avvio... > (la sezione chiamata «Assistente dall’ultimo avvio») permette di rivedere e inserire le transazioni. L’assistente per il Rimborso di mutui e ipoteche (la sezione chiamata «Assistente per mutui e ipoteche») permette di configurare una transazione pianificata per ripagare un prestito con un tasso di interesse composto. L’editor transazioni pianificate (la sezione chiamata «Finestra di modifica della transazione pianificata») permette di creare e modificare le transazioni che stanno per essere inserite automaticamente nel registro.
Il metodo più semplice per configurare una transazione pianificata consiste nell’utilizzare come modello una transazione esistente nella finestra del registro di un conto. Selezionare la transazione da utilizzare come modello e poi selezionare o il pulsante Pianifica sulla barra degli strumenti o andare in Operazioni → Pianifica.... Verrà aperta la finestra dal titolo Crea Transazione pianificata.
	Nome: inserire un nome per la transazione pianificata. Questo verrà utilizzato nel campo della Descrizione per la transazione.

	Frequenza: selezionare l’intervallo di tempo intercorrente tra due pianificazioni. Le date in cui la transazione verrà inserita saranno visualizzate nel mini calendario in basso.

	Data d’inizio:selezionare una data iniziale per la transazione pianificata.

	Senza fine: se la transazione non ha un termine.

	Data di termine: selezionare una data finale per la transazione pianificata.

	Numero di occorrenze: inserire il numero di volte con cui si desidera che la transazione venga inserita nel registro.



Il pulsante Avanzate... apre la finestra dell’Editor transazioni pianificate per modificare la transazione. Questa è descritta nell’apposita sezione: la sezione chiamata «Finestra di modifica della transazione pianificata».
Finestra della transazione pianificata



La finestra per le transazioni pianificate permette di accedere alla lista delle transazioni pianificate e di crearle, modificarle o eliminarle; fornisce anche un calendario. Fermando il cursore per qualche secondo su una data visualizzata dal calendario, verrà mostrata una piccola finestra contenente l’elenco delle transazioni pianificate per quella stessa data; per chiudere la piccola finestra è sufficiente premere su di essa un’altra volta. Le date evidenziate in giallo sul calendario rappresentano i giorni in cui sono pianificate delle transazioni.
Il riquadro superiore della finestra delle transazioni pianificate contiene una lista delle transazioni pianificate attualmente impostate. Questa lista elenca il nome della transazione, se questa è attiva ai fini della pianificazione, la frequenza (mese o giorno) con cui la transazione deve essere inserita, l’ultima data in cui è stata inserita e la prossima data in cui verrà inserita.
Sul lato destro del riquadro è presenta una freccia rivolta verso il basso che, quando premuta,che permette di selezionare le caratteristiche visualizzate. Togliendo la spunta a una voce, questa verrà rimossa dal riquadro.
La barra degli strumenti di questa finestra contiene tre pulsanti per creare, cancellare o modificare una transazione pianificata. Premendo i pulsanti Nuovo o Modifica, verrà aperto l’Editor transazioni pianificate. Premendo invece Elimina verrà cancellata la transazione pianificata selezionata. Le stesse opzioni sono raggiungibili anche attraverso il menu Pianifica → Nuovo/Modifica/Cancella, nella scheda della Transazioni pianificate.
Al di sotto della lista delle transazioni pianificate, è posizionato il calendario delle "prossime scadenze"; qui è visualizzato il calendario fino all’anno seguente e sono evidenziate le date in cui sono previste delle transazioni pianificate. Cliccando su di una data nel calendario, verrà aperta una finestra con la lista delle transazioni pianificate per quella stessa data. Spostando il puntatore al di sopra di un’altra data, cambierà di conseguenza anche la lista delle transazioni. Cliccando di nuovo sul calendario verrà chiusa la finestra contenente la lista delle transazioni.
La finestra per le transazioni pianificate è accessibile sia dalla scheda del conto che da quella del registro attraverso la voce del menu Operazioni → Transazioni pianificate → Editor transazioni pianificate.


Stampare gli assegniStampare gli assegni



In GnuCash gli assegni sono stampati dal registro del conto. GnuCash fornisce la possibilità di stampare assegni con lo standard Quicken (anche nel formato US Letter) o di creare un formato personalizzato. Anche la posizione dell’assegno e il formato della data sono personalizzabili.
Per stampare un unico assegno in GnuCash, selezionare la transazione di cui stampare l’assegno e andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà per la stampa dell’assegno.
Per stampare più assegni in GnuCash eseguire una ricerca per trovare le transazioni che si intende stampare. Dalla finestra dei risultati della ricerca andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà di stampa degli assegni per stampare tutti gli assegni presenti nella finestra di ricerca.
La finestra per la stampa dell’assegno presenta due schede. La prima è denominata Opzioni e permette di impostare le opzioni più comuni per la stampa dell’assegno; la seconda, denominata Formato personalizzato permette di configurare la posizione dei vari campi sull’assegno. È utile a questo scopo stampare un assegno di prova su un foglio di carta e utilizzarlo per effettuare le correzioni necessarie.
La selezione preimpostata nella finestra delle Opzioni è l’assegno Quicken/Quickbooks (tm) US-Letter.
	Formato dell’assegno: provare prima con il formato Quicken e utilizzare il formato personalizzato se la posizione non è corretta.

	Posizione dell’assegno: permette di selezionare l’assegno da stampare: Top (in alto), Middle (in mezzo) o Bottom (in basso). L’opzione Personalizzato è da selezionare se la posizione degli assegni nella pagina non è corretta.

	Formato data: il valore predefinito visualizzato in questo campo è impostato nelle preferenze di GnuCash. Dalla lista a comparsa è possibile selezionare il formato della data desiderato. Il formato può essere cambiato utilizzando le righe denominate Mesi: e Anni:. Scegliendo Personalizzato sarà possibile impostare il formato della data nel campo Formato: (%m significa mese, %d significa giorno, %Y significa anno). Un esempio del formato selezionato è mostrato appena più sotto nella finestra.

	Indirizzo: l’indirizzo del beneficiario, se il formato dell’assegno contiene uno spazio dedicato e se si intende stampare un unico assegno.



La scheda del Formato personalizzato è divisa in due sezioni. La metà superiore (al di sopra della linea di divisione) contiene due colonne per l’inserimento delle coordinate X e Y della posizione del campo sull’assegno. Le posizioni nel formato di assegno personalizzato sono a partire da x = 0 sul lato sinistro dell’assegno, crescenti verso destra, e y = 0 dal lato superiore dell’assegno, crescenti verso il basso. (Se si utilizza una versione di GTK precedente alla 2.10, allora y = 0 è al bordo inferiore e positiva verso l’alto).
	Beneficiario:

	Data:

	Importo (in parole):

	Importo (in numeri):

	Indirizzo:

	Note:

	Promemoria:

	Importo suddivisioni

	Promemoria suddivisioni

	Conto suddivisioni



La parte della scheda del Formato personalizzato al di sotto della linea di divisione contiene i campi per il posizionamento dell’assegno all’interno della pagina. La Traslazione è la distanza dall’angolo superiore sinistro mentre la Rotazione rappresenta la rotazione in senso orario dell’assegno. 
Il campo Unità nella metà inferiore della finestra indica le unità da utilizzare per i campi in entrambe le metà della finestra.
Una volta che è stato premuto il tasto OK nella finestra di stampa dell’assegno, verrà visualizzata la finestra per la stampa di un documento di GnuCash. Premere di nuovo OK per stampare l’assegno.

Assistente per mutui e ipotecheAssistente per mutui e ipoteche



Questa procedura guidata crea una transazione pianificata per il rimborso di un prestito. Quando è utilizzato per creare una transazione pianificata, l’assistente crea una formula variabile in modo che l’interesse composto venga correttamente calcolato. Per avviare l’assistente occorre selezionare Operazioni → Transazioni pianificate → Rimborso di mutui e ipoteche... dal menu principale.’
L’assistente per il rimborso di mutui e ipoteche presenta all’avvio una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra rimarranno invariati in tutte le finestre dell’assistente.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

	Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Il pulsante Avanti permette di avanzare nella procedura.



La schermata seguente permette di inserire le informazioni essenziali per il prestito. Queste sono fornite normalmente dalla banca al momento della firma dei documenti da parte del debitore. Qui è inoltre possibile impostare il conto che la transazione pianificata utilizzerà per inoltrare il pagamento.
	Conto del mutuo: scegliere un conto per le transazioni di pagamento del mutuo o utilizzare il tasto «Nuovo...» per creare un nuovo conto per le transazioni.

	Importo: l’ammontare del prestito.

	Tasso d’interesse: inserire il tasso di interesse applicato al prestito.

	Tipo: scegliere il tipo di prestito. Se viene impostato il tasso fisso, il riquadro della frequenza è disabilitato.

	Frequenza di variazione del tasso di interesse: scegliere la frequenza con cui il tasso cambia e la data di inizio del cambiamento.

	Data d’inizio: selezionare la data in cui il prestito è stato acceso.

	Durata: inserire la durata del prestito.

	Mesi rimanenti: questo valore dovrebbe essere calcolato automaticamente. Scegliere il numero di mesi che mancano all’estinzione del prestito.



La schermata successiva è destinata all’impostazione del conto di garanzia, dell’assicurazione e delle opzioni delle tasse per il prestito; È utile soprattutto per i pagamenti dei mutui. Quando ognuna di queste opzioni è impostata, vengono abilitate delle pagine aggiuntive nell’assistente per impostare queste voci del pagamento. Tutte le pagine verranno descritte in questa sezione anche se alcune potrebbero non venire visualizzate se l’opzione corrispondente non è stata scelta.
	... usare un conto destinato a garanzia per i pagamenti?: questa opzione abilita l’utilizzo di un conto impostato per tracciare i pagamenti a garanzia. Se il mutuo o il prestito utilizzano un conto destinato a garanzia per il pagamento delle tasse, dell’assicurazione ecc... allora si imposti il conto qui.

	... pagare imposte?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento delle tasse.

	... pagare assicurazione?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento dell’assicurazione.

	... pagare "PMI"?: aggiunge una schermata per impostare una transazione pianificata per il pagamento della PMI (Private Mortgage Insurance = assicurazione privata sul mutuo).

	... pagare altre uscite?: aggiunge una schermata addizionale per impostare una transazione pianificata dedicata al pagamento delle altre spese relative al prestito.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il rimborso del mutuo.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: visualizza le variabili utilizzate per il calcolo della rata da pagare.

	Pagamento da: scegliere un conto da cui pagare il prestito.

	Capitale a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso del capitale.

	Interessi a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso degli interessi.

	Remainder to: Choose an account to transfer the rest of the payment amount to.

	Frequenza: selezionare la frequenza delle rate e la data di inizio del rimborso.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle tasse.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle tasse.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle tasse.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle imposte.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell’assicurazione.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento della PMI.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento della PMI.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento della PMI.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell’assicurazione privata sui mutui ipotecari.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento dell’importo dell’assicurazione.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento dell’assicurazione.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento dell’assicurazione.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle altre spese.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle altre spese.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle altre spese.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle altre spese.



L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata per il prestito. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

	Il pulsante Indietro riporterà alla schermata precedente permettendo la modifica delle opzioni immesse in precedenza.

	Il pulsante Termina terminerà l’assistente e creerà la transazione pianificata.



Ora si dovrebbe avere la transazione pianificata per il rimborso del mutuo o del prestito, impostata correttamente.

Editor prezziEditor prezzi



L’editor prezzi è utile per modificare o registrare il valore di una valuta, di un fondo comune o di una azione. Esso fornisce un’unica interfaccia per aggiornare i valori di queste commodity ed è in grado di aggiornarle sia attraverso la ricezione di quotazioni via internet oppure manualmente.
Ogni elemento nell’editor rappresenta una registrazione del prezzo di una commodity o titolo:
	Titolo:  la commodity o il titolo di cui recuperare il prezzo. La visualizzazione è ordinata per mercato in cui i singoli titoli sono scambiati. L’elenco può essere espanso facendo clic sul simbolo a sinistra del nome.

	Valuta: la valuta con cui il prezzo è registrato.

	Data: la data in cui il prezzo è stato registrato.

	Fonte: la fonte del prezzo per la commodity. Generalmente, questa sarà o user:price-editor, a indicare che è stata immessa direttamente dall’utente, o Finance::Quote, a indicare che è stata ricevuta da una fonte online con il modulo Finance::Quote.

	Tipo: esistono diversi tipi di prezzi per le azioni.
	Offerta: indica il prezzo con cui un operatore specializzato è pronto ad acquistare un’azione.

	Domanda:  indica il prezzo con cui gli operatori sono pronti a vendere l’azione.

	Ultimo:  indica il prezzo con cui è avvenuto l’ultimo scambio per l’azione o titolo. Rappresenta il prezzo più comunemente utilizzato dai media.

	Valore netto delle attività: è tipicamente utilizzato per i fondi comuni. Sono generalmente calcolate sul valore netto dell’attività del fondo.

	Sconosciuto: utilizzare questa voce se il tipo di prezzo non è noto.




	Prezzo: il prezzo attuale della commodity.



Aggiungere manualmente il prezzo di un’azione



Per inserire un nuovo prezzo, premere Aggiungi e inserire i dettagli del titolo e del prezzo nel riquadro. Per modificare un prezzo esistente, selezionarlo dalla lista dei prezzi, premere il pulsante Modifica e modificare i dati presenti.
Per cancellare un singolo prezzo, selezionarlo e premere il pulsante Rimuovi. Per rimuovere tutti i prezzi più vecchi di una certa data, premere il pulsante Rimuovi vecchi e inserire i dettagli nella schermata visualizzata.
Verrà visualizzata una finestra con il messaggio "Cancella tutti i prezzi delle azioni in base al seguente criterio:". Inserire quindi la data dell’ultimo prezzo da cancellare.
Al di sotto del campo della data sono presenti due opzioni:
	Cancella i prezzi inseriti manualmente - se selezionata, verranno cancellati i prezzi immessi manualmente e datati precedentemente alla data specificata. Diversamente solo i prezzi aggiunti dal modulo Finance::Quote verranno cancellati.

	Cancella l’ultimo prezzo per un’azione - se selezionata, verranno cancellati i prezzi precedenti alla data specificata. Diversamente, l’ultimo prezzo precedente alla data specificata verrà conservato e tutte le quote più vecchie saranno cancellate.




Configurazione per l’utilizzo del pulsante Ricevi quotazioni



Per avere il supporto alla ricezione delle quotazioni tramite internet per una particolare azione o fondo comune, occorre prima di tutto abilitare l’opzione per la ricezione delle quotazioni e selezionare una fonte nell’Editor titolo. Questo processo è descritto in dettaglio in la sezione chiamata «Configurare titoli e valute per la ricezione online dei prezzi». Una volta abilitato il servizio e installato il modulo Finance::Quote, sarà possibile aggiornare le quotazioni delle proprie azioni e dei propri fondi comuni premendo semplicemente il pulsante Ricevi quotazioni.


Creare resoconti e graficiCreare resoconti e grafici



Nota
Questa sezione potrebbe dover essere aggiornata!!!

Se i resoconti forniti da GnuCash non soddisfano le proprie esigenze, è possibile crearne di nuovi. Per farlo è necessario conoscere Scheme (un linguaggio di programmazione simile a LISP) ed è anche consigliato avere accesso al codice sorgente di GnuCash.
L’interfaccia dei resoconti è documentata nel seguente file del codice sorgente src/report/report-system/doc/report-html.txt. Il file src/report/utility-reports/hello-world.scm nella distribuzione sorgente di GnuCash fornisce un buon esempio di come sviluppare un resoconto.
È inoltre necessario accedere ai dati dal cuore del programma al fine di ricevere i dati che si desidera inserire nel resoconto. Questa operazione è svolta da una serie di funzioni di Scheme documentate nel file src/g-wrap/gnc.html. Esaminando alcuni degli altri resoconti in src/scm/report, è possibile avere delle indicazioni sul loro utilizzo.
Attualmente, i resoconti sono prodotti richiamando una API di generazione HTML, che fornisce una dialettica di HTML e la disegna con un widget HTML. Questa procedura presenta delle limitazioni, in particolare qiuando si tenta di allineare gli oggetti con precisione, come può rendersi necessario per stampare su fatture pre-stampate.

Capitolo 9. Personalizzare GnuCashCapitolo 9. Personalizzare GnuCash



Opzioni di visualizzazione del conto



Il comando Filtra per è utilizzato per impostare o modificare la vista della finestra della struttura ad albero dei conti. La scheda dei Conti permette di selezionare la tipologia dei conti che devono essere mostrati. Queste impostazioni influenzano distintamente ogni finestra aperta della struttura dei conti.
La scheda Altro permette invece di abilitare o disabilitare due opzioni: se visualizzare i conti nascosti e se mostrare i conti che hanno un totale nullo.
La finestra della struttura dei conti, mostra di default solamente la quantità di ogni commodity che si possiede, nella colonna del Totale. Spesso, però, può essere utile visualizzare altri valori; per fare questo si può premere il pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso sul lato destro della barra del titolo nella finestra principale dei conti) e selezionare le voci da visualizzare. Queste scelte influenzano tutte le finestre aperte della struttura dei conti.


Impostare le preferenzeImpostare le preferenze



The GnuCash Preferences window allows you to customize your GnuCash 
    session by setting several options. From the GnuCash menu
    select Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
    The GnuCash Preferences window will open. 
    Using the tabs on the left make your desired changes.
Suggerimento
Fermando il cursore per qualche secondo sopra le opzioni presenti in questa finestra, verranno mostrate delle descrizioni più approfondite sulla voce selezionata.

Nota
Le modifiche effettuate verranno applicate immediatamente.

Per chiudere la finestra delle Preferenze di GnuCash, premere il pulsante Chiudi.
Ogni scheda della finestra delle Preferenze di GnuCash ha una sezione dedicata nel seguito. Per un elenco delle schede, consultare Capitolo 9, Personalizzare GnuCash.
Periodo contabile



Figura 9.1. La scheda Preferenze — Periodo contabile
[image: La scheda del Periodo contabile]




	Data d’inizio - specifica l’inizio del periodo contabile.
	Relativa — utilizza la data iniziale relativa specificata per calcolare i guadagni, le perdite e le attività nette. L’inizio relativo è definito da: oggi o l’inizio dell’attuale o precedente anno, trimestre o mese.

	Assoluta — utilizza la data iniziale assoluta specificata per calcolare i guadagni, le perdite e le attività nette.




	Data di termine — specifica la fine del periodo contabile.
	Relativa — utilizza la data finale relativa specificata per calcolare i guadagni, le perdite e le attività nette.

	Assoluta — utilizza la data finale assoluta specificata per calcolare i guadagni, le perdite e le attività nette.




	Contenuto della barra di riepilogo
	Includi somma complessiva — se attivata, verrà mostrata nella barra di riepilogo una somma complessiva di tutti i conti utilizzando la valuta predefinita.

	Includi i totali diversi dalle valute — se questa opzione è selezionata, GnuCash includerà nella barra di riepilogo un totale per gli elementi diversi dalla valuta (in pratica il numero di quote).







Conti



Figura 9.2. La scheda Preferenze — Conti
[image: La scheda Conti]




	Carattere separatore — il separatore del conto è il carattere che separa un conto padre dai suoi sottoconti, per esempio Bollette:Elettricità. Il valore predefinito è : (Colon), ma è anche possibile selezionare / (Slash), \ (Backslash), - (Dash),  . (Period) o qualsiasi altro carattere Unicode che non sia una lettra o un numero.

	Conti con saldo invertito — se i saldi dei conti devono avere un valore positivo o negativo: 
	Entrate e uscite assegna un saldo a credito positivo ai conti delle entrate a un saldo a debito negativo ai conti delle uscite. Consultare la sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.

	Conti crediti (predefinita) visualizza un saldo positivo per i conti che normalmente hanno un saldo in credito (entrate, crediti, passività, capitali). Consultare la sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.

	Nessuno mostra tutti i saldi a credito come negativi e tutti i saldi a debito come positivi.




	Etichette — selezionare questa opzione per fare in modo che le colonne del registro riportino i termini Debiti e Crediti invece delle diciture informali come Prelievo e Deposito. 

	Valuta predefinita — questa opzione permette di selezionare la valuta impostata dal sistema come predefinita per la creazione di nuovi conti.
	Locale — utilizza la valuta predefinita di sistema per tutti i nuovi conti creati.

	Altra: — la valuta da utilizzare, indipendentemente dalle impostazioni di sistema.







Impresa



Figura 9.3. La scheda Preferenze — Impresa
[image: La scheda Impresa]




	Generali
	Apri in una nuova finestra — se selzionata, ogni registro verrà aperto in una nuova finestra in primo piano. Diversamente, il registro verrà aperto nella finestra corrente.

	Accumula suddivisioni all’emissione — se accumulare automaticamente tutte le voci di una fattura che trasferiscono verso lo stesso conto, in un’unica suddivisione.




	Fatture
	Tasse incluse — indica se le tasse sono già incluse nelle voci delle fatture. Questa impostazione sarà applicata ai nuovi clienti e venditori.




	Ricevute
	Notifica scadenze — specifica se si vuole essere notificati all’avvio di GnuCash delle ricevute in scadenza.

	Giorni in anticipo — quanti giorni in anticipo avvisare delle ricevute in scadenza.

	Tasse incluse — indica se le tasse sono già incluse nelle voci delle ricevute. Questa impostazione sarà applicata ai nuovi clienti e venditori.







Data e ora



Figura 9.4. La scheda Preferenze — Data e ora
[image: La scheda Data e ora]




	Formato della data
	Usa orologio a 24 ore — permette di specificare se utilizzare il formato dell’ora a 12 o 24 ore. Cioé se le 11 di notte debbano essere rappresentate come 11PM o 23:00.l’




	Formato della data — questa opzione controlla l’aspetto della data (un’anteprima della data è visualizzata a fianco di ciascuna scelta disponibile). Le scelte disponibili soo:
	Locale — usa il formato di data predefinito del sistema.

	US — utilizza il formato di data proprio degli Stati Uniti.

	UK — utilizza il formato di data proprio del Regno Unito.

	Europa — utilizza il formato di data proprio dell’Europa continentale.

	ISO — utilizza il formato di data specificato dallo standard ISO-8601.







Generali



Figura 9.5. La scheda Preferenze — Generali
[image: La scheda Generali]




	Generali
	Visualizza la finestra del «suggerimento del giorno» — questa opzione permette di abilitare o disabilitare la visualizzazione all’avvio di GnuCash della finestra del Suggerimento del giorno.

	Visualizza i suggerimenti all’avvio è utile per abilitare o disattivare il suggerimento del giorno all’avvio di GnuCash.

	Esegui la procedura guidata per la struttura conti — questa opzione disabilita la visualizzazione dell’assistente per l’Impostazione di una nuova struttura dei conti quando viene selezionata la voce File → Nuovo file dal menu di GnuCash.




	Numeri
	Visualizza importi negativi in rosso — Se viene abilitata questa opzione, GnuCash visualizzerà gli importi negativi in rosso.

	Posizioni decimali automatiche — inserisce automaticamente un punto decimale nei valori che sono digitati senza.

	Posizioni decimali — il numero di posizioni decimali da utilizzare.




	File
Nota
Le opzioni seguenti sono rilevanti solamente per i file salvati in formato XML.

	Comprimi: — Questa opzione ndica se i file dei dati di GnuCash debbano essere compressi o meno.

	Visualizza la richiesta di conferma per il salvataggio automatico — se abilitata, GnuCash visualizzerà una schermata di conferma ogni volta che viene avviata la procedura di salvataggio automatico.

	Intervallo di salvataggio automatico — i minuti intercorrenti tra un salvataggio automatico del file e uno successivo. Impostare a 0 per disabilitare la funzione di salvataggio automatrico.

	Conserva i file di log per: — in questa sezione è possibile impostare le preferenze relative ai file di log.
	Mai — disabilita la creazione dei file di log.

	Per: — inserire un numero di giorni per cui conservare i file.

	Per sempre — disabilita la cancellazione automatica dei file di log; conserva i file di log per sempre.







	Finestra di ricerca
	Soglia per una nuova ricerca — apre una nuova ricerca se il numero di risultati trovati è inferiore al numero impostato qui.







Online Banking



Figura 9.6. La scheda Preferenze — Online Banking
[image: La scheda Online Banking]




	Importazione file QIF
	Visualizza la documentazione — la prima volta che si utilizza la procedura di importazione di file QIF vengono visualizzate delle istruzioni dettagliate su come importare un file. Una volta che si è acquistata familiarità con il procedimento, si potrebbe voler disattivare questa opzione rendendo il processo più veloce.




	Importatore generico
	Utilizza la corrispondenza Bayesiana — opzione per attivare o disattivare l’utilizzo degli algoritmi Bayesiani per trovare le corrispondenze tra le nuove transazioni e i conti esistenti.

	Soglia di visualizzazione — il punteggio minimo che una possibile corrispondenza deve avere per essere visualizzata nella lista delle corrispondenze.

	Soglia di auto-inserimento — una transazione il cui punteggio migliore ricade nella zona rossa (al di sopra della soglia di visualizzazione, ma inferiore o uguale alla soglia di auto-inserimento), verrà inserita automaticamente.

	Soglia di auto-liquidazione — una transazione il cui punteggio migliore ricade nella zona verde (superiore o al limite uguale al valore della soglia di auto-inserimento) verrà liquidata automaticamente.

	Soglia per i costi degli ATM commerciali — in alcune zone, gli sportelli commerciali ATM (che non fanno capo a una particolare istituzione finanziaria) sono installati in luoghi come i centri commerciali. Questi sportelli addebitano direttamente l’importo sul totale invece di farlo figurare con una transazione separata o nell’estratto conto mensile della banca. Per esempio, se si prelevano €100 si può essere addebitati di €101,50. Se si fosse inserito manualmente l’addebito dei soli €100, gli importi non corrisponderebbero. Questa opzione dovrebbe essere impostata al valore massimo di questa tassa applicato nella propria area (in un’unità della propria valuta), in modo che le transazioni vengano riconosciute nel processo di identificazione delle corrispondenze.




	Online Banking
Nota
Questa scheda è mostrata solamente se GnuCash è compilato con il supporto ad Aqbanking e HBCI.

	Ricorda PIN — abilitare questa opzione per fare in modo che GnuCash ricordi il PIN inserito per l’autenticazione all’online banking.

	Messaggi di debug prolissi — abilitare questa opzione per fare in modo che GnuCash mostri informazioni iù dettagliate relativamente alle operazioni di online bancking.







Stampa



Figura 9.7. La scheda Preferenze — Stampa
[image: La scheda Stampa]




La scheda Stampa permette di configurare alcune opzioni che governano la stampasu carta degli assegni.
	Stampa il formato della data — abilitare questa opzione per stampare sugli assegni il formato della data (nel tipo a 8 punti) sotto alla data.

	Stampa i caratteri di blocco — abilitare questa opzione per stampare una serie di tre asterischi prima e dopo ogni campo di testo sull’assegno.

	Carattere predefinito — premere il pulsante di sinistra per aprire una finestra di Selezione del tipo di carattere in cui è possibile personalizzare il carattere da utilizzare per la stampa su carta degli assegni.




Registro



Figura 9.8. La scheda Preferenze — Registro
[image: La scheda Registro]




	Operazioni
	«Invio» inserisce una riga con una transazione vuota — se attivata, premendo il tasto Invio il cursore verrà spostato all’ultima transazione vuota alla fine del registro. Diversamente il cursore si sposterà alla riga successiva.

	Espandi liste automaticamente — se selzionata, tutte le liste verranno automaticamente espanse quando l’input è focalizzato nel campo lista.

	La sequenza di «Tab» include il campo «Trasferimento» per le transazioni memorizzate — se selezionata, quando la transazione è completata automaticamente, premendo il tasto Tab nel registro, il salto del cursore includerà il campo Trasferimento.




	Riconciliazione
	Spunta le transazioni liquidate — se selezionata, verranno spuntate automaticamente le transazioni liquidate al momento della riconciliazione.

	Trasferimento automatico degli interessi — se attivata, prima della riconciliazione di un conto che matura o addebita interessi, verrà richiesto se inserire una transazione per gli interessi. Attualmente questa impostazione ha effetto solamente sui seguenti tipi di conti: banca, credito, fondo comune, attività, debiti e crediti correnti e passività.

	Pagamento carta di credito automatico — se selezionata, dopo la riconciliazione del conto della carta di credito, verrà richiesto un pagamento con la carta di credito.

	Riconcilia sempre a oggi — se selezionata, la finestra di riconciliazione viene aperta con la data odierna, indiffirentemente dalla data della riconciliazione precedente.




	Grafica
	Utilizza i colori del tema di sistema — se attivata, verranno utilizzati i colori del tema di sistema per la decorazione delle finestre del registro. Se disattivata, verranno utilizzati i colori originali di GnuCash.

	I colori della modalità a doppia linea si alternano tra le transazioni — se attivata, configura la finestra del registro in modo da alternare i colori primario e secondario per ogni transazione, invece che per ogni riga.

	Disegna delle linee orizzontali fra le righe — se selezionata, GnuCash disegnerà delle linee orizzontali tra ogni riga.

	Disegna delle linee verticali fra le colonne — se selezionata, GnuCash disegnerà delle linee verticali tra ogni colonna.







Predefinite del registro



Figura 9.9. La scheda Preferenze — Predefinite del registro
[image: La scheda Predefinite del registro]




La scheda delle preferenze Predefinite del registro influenza il comportamento delle finestre del registro delle transazioni.
	Stile predefinito
Qui è possibile scegliere tra 3 diversi stili per la finestra del registro: 
	Libro mastro basilare — visualizza tutte le transazioni su una riga singola (due nella modalità a doppia linea).

	Mastro a espansione automatica 
             

             
              Giornale della transazione 
             
            




	Altre predefinite
	Il registro verrà aperto in una nuova finestra — se selezionata, il registro del conto verrà aperto in una nuova finestra invece che in una scheda.

	Modalità a doppia linea — visualizza due righe di informazioni per ogni transazione in luogo di una unica.

	Visualizza solamente i nomi dei sottoconti — se selezionata, verranno visualizzati solamente i nomi dei sottoconti nel campo di selezione del Conto. Il comportamento predefinito prevede la visualizzazione del nome completo del conto con incluso il suo percorso nella struttura dei conti.
Avvertimento
Abilitare questa opzione presuppone che vengano utilizzati dei nomi unici per i conti figli.


	Numero di transazioni — quante transazioni visualizzare nel registro. Un valore nullo significa che verranno visualizzate tutte le transazioni.







Resoconti



Figura 9.10. La scheda Preferenze — Resoconti
[image: La scheda Resoconti]




La scheda delle preferenze Resoconti influisce sul comportamento dei resoconti di GnuCash.
	Valuta predefinita — questa opzione permette di selezionare la valuta da utilizzare come predefinita per creare i resoconti. È possibile scegliere tra:
	Locale — utilizza la valuta predefinita di sistema per tutti i nuovi resoconti.

	Altra — utilizza la valuta specificata in questo campo per tuti nuovi resoconti.




	Posizione
	Il resoconto viene aperto in una nuova finestra — se selezionata, i resoconti verranno aperti in una nuova finestra invece che in una scheda.







Transazioni pianificate



Figura 9.11. La scheda Preferenze — Transazioni pianificate
[image: La scheda Transazioni pianificate]




La scheda delle preferenze Transazioni pianificate governa il comportamento delle transazioni pianificate in GnuCash. Maggiori informazioni relative alle transazioni pianificate sono reperibili in la sezione chiamata «Pianificare le transazioni».
	Assistente dall’ultimo avvio
	Avvia all’apertura del file — se selezionata verrà visualizzato L’assistente dall’utlimo avvio all’avvio di GnuCash (o meglio quando GnuCash aprirà un file).




	Predefinite dell’editor transazioni
	Crea automaticamente le nuove transazioni — se selezionata, le nuove transazioni pianificate verranno inserite automaticamente nel registro. Se questa opzione viene abilitata, è anche possibile abilitare l’opzione Notifica prima che le transazioni vengano create in modo che sia possibile confermare la creazione delle transazioni.

	Crea in anticipo — i giorni d’anticipo con cui creare una transazione pianificata.

	Ricorda in anticipo — i giorni d’anticipo con cui ricorare la scadenza per l’immissione di una transazione pianificata.







Finestre



Figura 9.12. La scheda Preferenze — Finestre
[image: La scheda Finestre]




	Geometria finestra
	Salva la dimensione e la posizioen della finestra — se selezionata, al prossimo avvio GnuCash utilizzerà la dimensione e la posizione della finestra configurate nell’ultimo avvio.




	Stile della barra strumenti
È possibile scegliere tra cinque diversi stili per la barra degli strumenti:
	Utilizza predefinito di sistema (predefinito) — utilizza le impostazioni di sistema per visualizzare gli elementi della barra degli strumenti.

	Testo sotto alle icone — Visualizza la barra degli strumenti con l’etichetta di testo sotto all’icona. Le etichette verranno visualizzate per tutti gli elementi della barra.

	Testo accanto alle icone principali — visualizza gli elementi della barra degli strumenti con l’etichetta di testo accanto all’icona. Le etichette di testo verranno visualizzate solamente per gli elementi più importanti.

	Solo icone — visualizza solo le icone degli elementi della barra degli strumenti.

	Solo testo — visualizza solo il testo degli elementi della barra degli strumenti.




	Schede
	Visualizza il tasto di chiusura sulle schede — aggiunge una piccola icona per la chiusura su ogni scheda per renderne più semplice la chiusura.

	Porta la scheda più recente in primo piano — se selezionata, le nuove schede create verranno visualizzate al di sopra delle altre.

	Larghezza — la larghezza dell’etichetta delle schede epressa in caratteri.




	Posizione delle schede
Posiziona le schede in Alto (predefinita), in Basso, a Sinistra o a Destra.

	Posizione della barra di riepilogo
Posiziona la barra di riepilogo In alto o In basso (predefinita) nella finestra principale di GnuCash.





Cambiare la linguaCambiare la lingua



La lingua dell’interfaccia di GnuCash non è direttamente modificabile dalle preferenze del programma.
Il metodo per cambiare lingua del programma dipende dal sistema operativo in cui GnuCash viene eseguito.
	Linux
	In genere è necessario impostare le variabili di sistema LANGUAGE e LANG prima di avviare GnuCash. Per farlo occorre aprire una finestra di terminale ed eseguire il seguente comando:
LANGUAGE=ll_LL LANG=ll_LL gnucash
ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per l’italiano ecc...)
Nota
In alcuni sistemi (per esempio Ubuntu) la codifica può far parte del nome, come ll_LL.UTF-8.


	MacOSX
	Per utilizzare una traduzione diversa da quella selezionata automaticamente, è possibile eseguire il seguente comando in Terminal.app:
defaults write $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app) AppleLanguages "(de, en)"
È possibile usare qualsiasi codice di lingua si desideri, in luogo di Tedesco (de) e Inglese (en). Comunque, se il file per la traduzione non è presente, il comando non funzionerà.
Per reimpostare i valori originali, eseguire:
defaults delete $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app)

	Finestre™
	Se si sta eseguendo GnuCash 2.4.0 (o successivo) su Windows, è possibile impostare la lingua dell’interfaccia modificando il file environment con un editor di testo (per esempio Notepad). Di norma questo file è installato nella cartella c:\Programmi\gnucash\etc\gnucash. Modificare il file in modo che le ultime righe siano come le seguenti:

	  
# If you wish GnuCash to use a different language, uncomment the two parameters
# below and set LANG to your preferred locale
LANG=ll_LL
LANGUAGE={LANG}

	  
ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per l’italiano ecc...)



Suggerimento
Maggiori e più aggiornate informazioni relative all’argomento possono essere reperite sulla pagina delle impostazioni della lingua nel wiki di GnuCash.
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Codici delle borse per i mercati Europei



Lista dei codici delle borse per i mercati Europei
Tabella A.1. Lista dei codici delle borse per i mercati Europei
	Codice
	Mercato

	BC
	Barcellona

	BE
	Berlino

	BI
	Bilbao

	BR
	Brême

	CO
	Copenhagen

	D
	Dusseldorf

	F
	Francoforte

	DE
	Xetra (was FX)

	H
	Hamburg

	HA
	Hanover

	L
	Londra

	MA
	Madrid

	MC
	Madrid (M.C.)

	MI
	Milano

	MU
	Monaco

	O
	Oslo

	PA
	Parigi

	ST
	Stoccolma

	SG
	Stuttgart

	VA
	Valence

	VI
	Vienna







1. APPLICABILITY AND DEFINITIONS1. APPLICABILITY AND DEFINITIONS



This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The «Document», below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as «you».
A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.
A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.
The «Invariant Sections» are certain  Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.
The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.
A «Transparent» copy of the  Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.
The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

AddendumAddendum



To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices just after the title page:
Copyright Cristian Marchi, 2011
Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.1 or any later version published by the Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy of the license is included in the section entitled «GNU Free Documentation License».


If you have no Invariant Sections, write «with no Invariant Sections» instead of saying which ones are invariant. If you have no Front-Cover Texts, write «no Front-Cover Texts» instead of «Front-Cover Texts being LIST»; likewise for Back-Cover Texts.
If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software license, such as the  GNU General Public License, to permit their use in free software.
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